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ABSTRAK 

 

Pemantauan kecepatan dan arah angin penting dalam pengelolaan tambak udang, 

karena angin dapat memengaruhi sirkulasi udara, suhu, dan tingkat oksigen di air 

tambak. Penelitian ini bertujuan untuk mengembangkan sistem pemantauan angin 

berbasis Internet of Things (IoT) di tambak udang di Desa Lubuk Bayas, 

Kecamatan Perbaungan, Kabupaten Serdang Bedagai, Sumatera Utara. Sistem ini 

menggunakan sensor angin yang terhubung ke platform IoT untuk mengirimkan 

data secara real-time. Informasi tersebut dapat diakses melalui web atau perangkat 

mobile, memungkinkan pengelola tambak memantau kondisi angin dengan cepat 

dan akurat. Hasil penelitian menunjukkan sistem ini dapat memantau kecepatan dan 

arah angin dengan baik, serta mendukung operasional tambak udang. 

 

Kata kunci : IoT, pemantauan angin, tambak udang, kecepatan angin, arah angin. 
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ABSTRACT 

 

Monitoring wind speed and direction is important in managing shrimp ponds, 
because wind can affect air circulation, temperature and oxygen levels in pond 
water. This research aims to develop an Internet of Things (IoT) based wind 
monitoring system in shrimp ponds in Lubuk Bayas Village, Perbaungan District, 
Serdang Bedagai Regency, North Sumatra. This system uses wind sensors 
connected to an IoT platform to transmit data in real-time. This information can 
be accessed via the web or mobile devices, allowing farm managers to monitor 
wind conditions quickly and accurately. The research results show that this 
system can monitor wind speed and direction well, and support shrimp pond 
operations. 
 
 

Keywords : IoT, wind monitoring, shrimp farming, wind speed, wind direction 
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BAB 1 

PENDAHULUAN 

 

1.1   Latar Belakang 

 Tambak udang merupakan salah satu sektor perikanan yang memiliki 

potensi ekonomi besar di Indonesia, termasuk di Desa Lubuk Bayas, Kecamatan 

Perbaungan, Kabupaten Serdang Bedagai, Sumatera Utara. Namun, pengelolaan 

tambak udang memerlukan perhatian khusus terhadap berbagai faktor lingkungan, 

salah satunya adalah kondisi angin. Kecepatan dan arah angin memengaruhi 

kualitas udara di sekitar tambak, yang berdampak langsung pada sirkulasi oksigen 

dalam air, suhu lingkungan, serta keseimbangan ekosistem tambak. Perubahan 

signifikan dalam kecepatan angin dapat memicu turbulensi pada permukaan air, 

yang berpotensi mengganggu kondisi ideal bagi budidaya udang. 

 Dalam beberapa tahun terakhir, Internet of Things (IoT) telah menjadi topik 

yang semakin penting dan menarik dalam dunia teknologi. IoT mengacu pada 

koneksi jaringan antara berbagai perangkat keras, termasuk sensor, perangkat 

seluler, dan perangkat pintar, yang kemudian dapat saling berkomunikasi dan 

berinteraksi melalui internet. Keterbatasan komputasi dan penyimpanan pada 

perangkat IoT disebabkan oleh penggunaan komponen yang terbatas, sementara 

pada cloud computing memiliki kapasitas penyimpanan dan komputasi yang besar 

karena berada pada lingkungan virtual (Nashrullah and Afrianto 2023). 

 Angin merupakan pergerakan massa udara secara mendatar. Angin dapat 

terjadi jika pada suatu saat terdapat perbedaan tekanan antara satu tempat dengan 

tempat yang lain. Udara bergerak dari daerah bertekanan tinggi ke daerah 

bertekanan rendah. Arah dan kecepatan memiliki peranan dalam mempengaruhi  

curah hujan. Ketika angin berhembus dari arah samudera pasifik atau samudera 

Indonesia, maka angin akan membawa udara lembab menjadi hujan tinggi. (Dwi et 

al. 2022) 

 Masyarakat, khususnya para petani tambak udang di desa lubuk bayas, 

semakin resah dengan minimnya pemantauan kecepatan dan arah angin yang 

berdampak signifikan terhadap keberhasilan budidaya tambak. Mereka menyadari 
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bahwa perubahan angin yang tidak terdeteksi dapat menyebabkan 

ketidakseimbangan lingkungan tambak, yang memengaruhi kadar oksigen, suhu 

air, dan kualitas air secara keseluruhan. Kondisi ini berdampak langsung pada 

kesehatan udang, meningkatkan risiko stres, penyakit, bahkan kematian udang 

dalam jumlah besar. 

 Oleh karena itu, penelitian ini bertujuan untuk merancang dan 

mengimplementasikan sistem pemantauan kecepatan dan arah angin berbasis IoT 

di tambak udang di Desa Lubuk Bayas. Sistem ini diharapkan mampu memberikan 

solusi yang efektif untuk memantau kondisi angin secara real-time, sehingga 

pengelola tambak dapat melakukan langkah-langkah preventif dalam menjaga 

kelangsungan ekosistem tambak udang. 

 

1.2   Rumusan Masalah 

Berdasarkan uraian latar belakang,maka diperoleh sutau rumusan masalah : 

1. Bagaimana meningkatkan pemahaman masyarakat pengelola tambak 

udang mengenai teknologi IoT dalam budidaya tambak udang. 

2. Bagaimana pengaruh kecepatan dan arah angin terhadap pertumbuhan 

dan produksi udang di tambak. 

3. Bagaimana mendesain alat pemantauan kecepatan dan arah angin 

yang efektif untuk mendukung budidaya tambak udang. 

 

1.3 Ruang Lingkup 

Ruang lingkup penelitian mencakup Pemilihan dan integrasi sensor 

kecepatan dan arah angin. Implementasi sistem IoT untuk pemantauan secara real-

time. Pengumpulan data di lokasi tambak udang tertentu. Analisis data untuk 

mendapatkan informasi yang relevan. 

 

1.4 Tujuan Penelitian  

1.4.1 Tujuan Umum 

Adapun tujuan dari penelitian tugas akhir ini yaitu untuk membuat alat 

pemantauan kecepatan dan arah angin pada tambak udang dengan menggunakan 

system iot agar meningkatkan produktivitas tambak udang. 

 

1.4.2 Tujuan Khusus 
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1. Untuk memperkenalkan teknologi system pemantau, dengan 

menggunakan system IOT 

2. Bagaimana alat bekerja dengan baik 

3. Untuk memantau data sebagai informasi pada masyarakat tambak udang. 

 

1.5 Manfaat Penelitian 

1. Optimasi Produksi Tambak Udang, 

Pemahaman terhadap pola angin akan membantu dalam mengoptimalkan 

penempatan tambak, menjaga kualitas air, dan menciptakan kondisi 

lingkungan yang mendukung pertumbuhan udang. 

2. Peningkatan Keberlanjutan, 

Dengan memanfaatkan data kecepatan dan arah angin, penelitian ini 

dapat memberikan kontribusi pada pengembangan praktik-praktik yang 

lebih berkelanjutan dan ramah lingkungan dalam budidaya tambak 

udang. 

3. Efisiensi Energi, 

Tenaga angin sebagai sumber daya alam yang melimpah di sekitar 

tambak udang dapat dimanfaatkan secara optimal untuk menggerakkan 

turbin. Hal ini akan mengurangi ketergantungan pada listrik dari sumber 

luar. 

4. Mitigasi Risiko Bencana, 

Pemantauan angin juga dapat berperan dalam mitigasi risiko bencana, 

seperti topan atau badai, dengan memberikan informasi yang diperlukan 

untuk pengambilan keputusan yang cepat dan efektif. 

 

 

 

 

 

 

 

 

 



4 

 

BAB 2 

TINJAUAN PUSTAKA 

 

2.1 Tambak 

Tambak adalah kolam buatan yang diisi air dan dimanfaatkan sebagai sarana 

budidaya perairan (akuakultur). Syarat terlaksananya kegiatan budidaya adalah 

adanya organisme yang dibudidayakan, media hidup organisme, dan wadah/tempat 

budidaya. Budidaya merupakan salah satu kegiatan dalam meningkatkan produksi 

perikanan. Metode pembudidayaan yang dilakukan dapat bersifat tradisional, semi 

intensif, dan intensif (Anwar and Abdurrohman 2020). 

Kesesuaian lahan merupakan salah satu aspek yang menentukan keberhasilan 

kegiatan budidaya tambak di wilayah pesisir. Budidaya tambak memiliki 

komponen keruangan serta perbedaan karakteristik biofisik dan sosial-ekonomi dari 

setiap lokasi. Banyak tambak intensif belum memanfaatkan kelebihan Sistem 

Informasi Geografis (SIG) dalam melakukan pemilihan lokasi dan pengelolaan 

budidaya, dimana hal tersebut penting dilakukan untuk menghindari kegagalan 

usaha (Setianingrum, Suprayogi, and Hani’ah 2014). 

 

2.2 Udang Vaname 

Udang vaname (Litopenaeus vannamei) atau dikenal dengan Pasific White 

Shrimp seperti pada gambar 2.1 merupakan jenis udang introduksi yang memiliki 

nilai ekonomi tinggi karena banyak dikonsumsi bukan hanya skala nasional akan 

tetapi mampu diekspor hingga kepasar Amerika dan dunia. Udang ini mulai masuk 

dan dibudidaya di Indonesia pada tahun 2001. Udang ini mulai menjadi alternatif 

seiring menurunnya tingkat produksi udang windu akibat terserang penyakit virus 

White Spot Syndrome Virus (WSSV) sehingga pertumbuhannya menjadi terhambat 

(Anwar and Abdurrohman 2020). 

Gambar 2.1 Udang vaname (Ibrahim 2018) 



5 

 

Udang vaname memilliki pertumbuhan yang relatif lebih cepat, tahan 

terhadap serangan penyakit, dan memiliki toleransi yang lebih baik dibanding jenis 

udang yang lainnya. Pertumbuhan udang vaname rata-rata 3 gram/minggu, dapat 

ditebar dengan kepadatan sampai 150 ekor/m2. Pemberian pakan udang vaname 

dilakukan 4 kali setiap hari dengan kandungan protein dengan pelet sebesar 30%. 

Untuk pemeliharaan pH air menggunakan kapur jika kondisi pH air naik dan jika 

kondisi pH air turun. Untuk mengatur tingkat suhu air pada tambak dengan 

mengatur ketinggian air tambak (Anwar and Abdurrohman 2020). 

 

2.3 Cuaca 

Cuaca merupakan salah satu hal yang sangat berpengaruh kepada kehidupan 

makhluk hidup.Perubahan cuaca yang tidak menentu terdapat di beberapa daerah 

di dunia. Seiring perkembangan jaman, kemajuan ilmu pengetahuan dan teknologi 

dapat dilakukan pendekatan guna memprediksi perubahan cuaca yang terjadi 

Sebagai contoh, kondisi udara pagi sampai siang hari udara cerah, tiba-tiba 

menjelang sore udara berawan dan terjadi hujan dengan intensitas lebat (Tambunan 

and Saputra 2022). 

 

2.3.1 Konsep Cuaca 

Cuaca adalah kaadaan udara pada saat tertentu dan diwilaya tertentu yang 

relatif sempit dan dalam jangka waktu yang singkat. Unsur-unsur yang 

mempengaruhi cuaca dan iklim adalah : 

1. Suhu udara perubahan suhu udara di satu tempat dengan tempat lainnya 

bergantung pada ketinggian tempat dan letak astronomisnya (lintang). 

Perubahan suhu karena perbedaan ketinggian jauh lebih cepat daripada 

perubahan suhu karena perbedaan letak lintang. Biasanya, perubahan suhu 

terjadi berkisar 0,6 derajat celcius tiap kenaikan 100 m, alat ukur adalah 

Termometer (Puspita and Yulianti 2016). 

2.   Tekanan udara tekanan udara adalah berat massa udara pada suatu wilayah. 

Tekanan udara menunjukkan tenaga yang bekerja untuk menggerakkan 

massa udara dalam setiap satuan luas tertentu. Tekanan udara semakin 

rendah jika semakin tinggi dari permukaan laut,alat ukur adalah Barometer 

(Puspita and Yulianti 2016). 
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3. Kelembaban udara : kelembaban udara adalah kandungan uap air dalam 

udara. Uap air yang ada dalam udara berasal dari hasil penguapan air di 

permukaan bumi, air tanah, atau air yang berasal dari penguapan tumbuh-

tumbuhan,alat ukur adalah Higrometer (Puspita and Yulianti 2016). 

 

2.4 Angin 

Indonesia merupakan negara yang memiliki berbagai julukan antara lain 

sebagai negara kepulauan, negara maritim, dan masih banyak lagi. Indonesia 

dijuluki sebagai negara kepulauan karena Indonesia memiliki beribu- ribu pulau 

besar dan kecil yang tersebar di seluruh Nusantara. Sebagai negara maritim, 

sebagian besar wilayah Indonesia adalah perairan dengan perbandingan antara 

daratan dan lautan sebesar 2 : 3. Selain itu letak geografis Indonesia sangat strategis 

karena berada diantara persilangan dua benua dan dua Samudra. Keberadaan 

wilayah Indonesia menyebabkan kondisi iklim dan cuaca yang berbeda-beda. 

Dimana setiap 6 bulan sekali akan terjadi angin muson barat dan angin muson timur. 

Perubahan iklim dan cuaca sangat penting untuk dipertimbangkan oleh para 

penduduk disekitar pesisir khususnya nelayan dalam mencari mata pencaharian 

(Soewarianto at al., 2022).  

Melihat hal tersebut angin sangat penting bagi manusia. Angin memberikan 

manfaat yang luarbiasa untuk manusia dalam menunjang perekonomian mereka. 

Namun selain menguntungkan untuk manusia angin juga dapat merugikan bagi 

manusia (Samsinar et al., 2020)(Amindri 2023). 

Angin merupakan pergerakan massa udara secara mendatar. Angin dapat 

terjadi jika pada suatu saat terdapat perbedaan tekanan antara satu tempat dengan 

tempat yang lain. Udara bergerak dari daerah bertekanan tinggi ke daerah 

bertekanan rendah, Pergerakan angin dapat diketahui polanya dengan 

menggunakan data arah dan kecepatan angin yang dilakukan selama 24 jam. Arah 

dan kecepatan memiliki peranan dalam mempengaruhi curah hujan. Ketika angin 

berhembus dari arah samudera pasifik atau samudera Indonesia, maka angin akan 

membawa udara lembab menjadi hujan tinggi dan bahwa kelembaban udara, 

tekanan udara, temperature, arah dan kecepatan angin yang mempengaruhi curah 

hujan (Dwi et al. 2022). 
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2.5 Anemometer 

Anemometer seperti pada gambar 2.2 adalah sebuah perangkat untuk 

mengukur kecepatan angin dan untuk mengukur arah angin. Anemometer 

merupakan salah satu instrumen yang sering digunakan oleh Badan Meterologi 

Klimatologi dan Geofisika (BMKG). Kata anemometer berasal dari Bahasa Yunani 

anemos yang berarti angin, angin merupakan udara yang bergerak ke segala arah, 

angin bergerak dari suatu tempat menuju ke tempat yang lain. Anemometer ini 

pertama kali diperkenalkan oleh Leon Batista Alberti dari italia pada tahun 1450 

(BMKG 2000) 

 

Gambar 2.2 Anemometer (BMKG 2000) 

Kecepatan angin adalah kecepatan udara yang bergerak secara horizontal 

yang dipengaruhi oleh gradien barometris letak tempat, tinggi tempat, dan keadaan 

topografi suatu tempat.Untuk pengukuran kecepatan angin yang lebih baik memang 

dilakukan pada ketinggian 10 m, dengan pertimbangan efek dari lapisan perbatas. 

Untuk satuan kecepatan angin dalam meter per detik, kilometer per jam atau knot 

(1 m/s = 1,9438 knots = 3,6 km/jam). Berdasarkan pengertiannya kecepatan angin 

tidak pasti atau selalu berubah-ubah dalam setiap keadaan maka yang harus 

dilakukan adalah melakukan pengamatan melalui skala standar internasional yaitu 

dengan menggunakan skala Beaufort (Wijayanti, Rahmawati, and Sucahyo 2015) 

Alat ukur kelajuan dan arah angin yang umum digunakan pada stasiun 

pengamat cuaca adalah Anemometer jenis Cup Counter yang menerapkan metode 

mekanik dalam pengukurannya. Anemometer jenis Cup Counter adalah alat yang 

digunakan untuk mengukur laju angin dengan tiga buah cup sebagai sensor yang 
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dihubungkan oleh lengan ke couter. Prinsip kerja alat ini yaitu apabila angin bertiup 

maka rotor berputar pada arah tetap disebabkan karena seluruh cup menghadap ke 

satu arah melingkar. Perputaran sumbu sistem Cup dihubungkan secara mekanik 

dengan generator sinyal sebagai pencatatan sinyal (Yanti, Yulkifli, and Kamus 

2016). 

Penelitian ini dirancang sistem monitoring kecepatan dan arah angin.Alat 

ukur kecepatan dan arah angin berbasis Arduino yang diharapkan mampu 

mengukur perubahan angin lebih presisi dengan menggunakan sensor optocoupler 

yang tergolong murah danmemiliki kualitas baik. Pada perancangan kecepatan dan 

arah angin ini menggunakan software arduino yang dimanfaatkan sebagai interface 

antara PC dengan sensor (Wijayanti, Rahmawati, and Sucahyo 2015) 

Pembuatan alat pengukur kecepatan angin dapat memanfaatkan teknologi 

mikrokontroler. Sama halnya dengan sistem komputer, mikrokontroler mempunyai 

kemampuan untuk diprogram sesuai dengan kebutuhan pembuatan alat pengukur 

kecepatan angin. Dan di tambahkan wirelees sebagai penghubung menggantikan 

fungsi kabel. Pada alat pengukur kecepatan angin terdapat baling-baling atau 

mangkok yang berputar sesuai dengan arah angin. Makin besar kecepatan angin, 

makin cepat putaran mangkok-mangkok tersebut. Dari jumlah putaran dalam satu 

detik maka dapat diketahui kecepatan anginnya. Untuk mendeteksi jumlah putaran 

mangkok-mangkok pada anemometer digunakan sensor optocoupler (Dejan 2019). 

 

2.6 Sistem Monitoring 

Sistem Monitoring merupakan sistem yang mampu melakukan pemantauan, 

pengamatan, dan pengawasan. Monitoring bertujuan untuk memberikan suatu 

informasi keberlangsungan proses untuk menetapkan langkah menuju ke arah 

perbaikan yang berkesinambungan. Monitoring dapat didefinisikan siklus kegiatan 

yang mencakup pengumpulan informasi, peninjauan ulang atau review, report dan 

tindakan atas informasi suatu proses yang sedang diimplementasikan. Biasanya 

data sistem monitoring yang dikumpulkan bersifat real time (Ariyani 2022). 

Secara garis besar tahapan dalam sebuah sistem monitoring terbagi ke dalam 

tiga proses yaitu pengumpulan data monitoring, penganalisisan data monitoring 

serta proses penampilan data hasil monitoring. Monitoring yang masih bersifat 

konvensional memiliki kelemahan antara lain data hasil monitoring tidak akurat, 
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membutuhkan waktu yang lama untuk memonitoring dengan mengambil sampel 

untuk diamati lalu di bawa ke laboratorium atau menggunakan peralatan sensor, 

memonitoring suatu keadaan serta membutuhkan aktifitas yang lebih banyak dalam 

pengumpulan data hasil monitoring yang diinginkan (Ariyani 2022) 

Perkembangan teknologi yang semakin maju merupakan faktor utama dalam 

perkembangan sistem monitoring saat ini. Seperti pada sistem monitoring kualitas 

air pada kolam budidaya ikan yang dilakukan oleh dengan melakukan pengukuran 

parameter kualitas air menggunakan sensor dan mengirimkannya ke perangkat 

gateway secara real time menggunakan jaringan sensor nirkabel (Ariyani 2022). 

 

2.7 Software Arduino IDE 

Integrated Development Environment (IDE) seperti pada gambar 2.3 atau 

secara bahasa merupakan lingkungan terintegrasi yang digunakan untuk melakukan 

pengembangan. Disebut sebagai lingkungan karena melalui software inilah 

Arduino dilakukan pemrograman untuk melakukan fungsi-fungsi yang dibenamkan 

melalui sintaks pemrograman. Arduino IDE menggunakan bahasa pemrograman 

sendiri yang menyerupai bahasa C++. Bahasa pemrograman Arduino (Sketch) 

sudah dilakukan perubahan untuk memudahkan pemula dalam melakukan 

pemrograman dari bahasa aslinya. Sebelum dijual ke pasaran, IC mikrokontroler 

Arduino telah ditanamkan 21 suatu program bernama Bootlader yang berfungsi 

sebagai penengah antara compiler Arduino dengan mikrokontroler (Ariyani 2022). 

 

Gambar 2.3 Tampilan sketch Arduino IDE (Ariyani 2022) 
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1. Berdasarkan Gambar 2.3 dapat dijelaskan bahwa fungsi dari komponen 

pada sketch Arduino IDE sebagai berikut. 

2. Verifity atau dikenal dengan compile, untuk memastikan program yang 

dibuat sudah benar dan tidak terdapat kesalahan atau Error. Proses ini untuk 

mengubah sketch menjadi kode biner untuk diunggah ke mikrokontroler.  

3. Upload berfungsi untuk mengunggah sketch ke board Arduino.  

4. New sketch berfungsi untuk membuka window dan sketch baru.  

5. Open sketch berfungsi untuk membuka sketch yang sudah dibuat dan 

disimpan sebelumnya dengan format file “.ino”.  

6. Save sketch berfungsi untuk menyimpan sketch.  

7. Serial monitor berfungsi untuk membuka interface sebagai komunikasi  

serial. 

8. Sketch berfungsi sebagai tempat untuk menuliskan program  

9. Keterangan aplikasi berfungsi untuk menampilkan pesan seperti saat proses 

“compiling” dan “done uploading”.  

10. Konsol berfungsi untuk menampilkan pesan yang sedang dikerjakan dan 

memberikan informasi tentang sketch yang dibuat.  

11. Port berfungsi untuk menginformasikan port yang sedang dipakai dalam 

board Arduino (Ariyani 2022). 

 

 

2.7 Iot (internet of things) 

Internet of Thing terdiri dari 2 kata kunci, Internet dan Things.Internet, 

memiliki arti interconnection-networking, dimana jaringan komputer yang 

terkoneksi satu dengan yang lain dengan menggunakan protokol TCP/IP 

(Transmission Control Protocol/ Internet Protocol).Things di dalam Internet of 

Things merupakan objek yang digunakan sehari hari dimana informasi diambil 

melalui sensor yang membaca keadaan lingkungan sekitar dengan real time dan 

tanpa adanya intervensi manusia. Seperti temperatur ruangan dan kelembapan 

udara (Gunawan, Akbar, and Giyandhi Ilham 2020). 
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2.8 Mikrokontroler ESP32 

Mikrokontroler ESP32 seperti pada gambar 2.4 merupakan mikrokontroler 

SoC (System on Chip) terpadu dengan dilengkapi WiFi 802.11 b/g/n, Bluetooth 

versi 4.2, dan berbagai peripheral. ESP32 adalah chip yang cukup lengkap, terdapat 

prosesor, penyimpanan dan akses pada GPIO (General Purpose Input Output). 

ESP32 bisa digunakan untuk rangkaian pengganti pada Arduino, ESP32 memiliki 

kemampuan untuk mendukung terkoneksi ke WI-FI secara langsung (Agus 

Wagyana, 2019). Adapun spesifikasi dari ESP32 adalah sebagai berikut.(Nizam, 

Haris Yuana, and Zunita Wulansari 2022) 

Board ini memeliki dua versi, yaitu 30 GPIO dan 36 GPIO. Keduanya 

memiliki fungsi yang sama tetapi versi yang 30 GPIO dipilih karena memiliki dua 

pin GND. Semua pin diberi label dibagian atas board sehingga mudah untuk 

dikenali. Board ini memiliki interface USB to UART yang mudah diprogram 

dengan program pengembangan aplikasi seperti Arduino IDE. Sumber daya board 

bisa diberikan melalui konektor micro USB [2](Nizam, Haris Yuana, and Zunita 

Wulansari 2022). 

 

Gambar 2.4 Mikrokontroler ESP32(Makrup, Amalia Herlina, and Fuad 

Hasan 2022) 

  

2.9 Google spreadsheet 

salah satu alat canggih yang saat ini familiar dan banyak digunakan dalam 

berbagai aktivitas. Smartphone dimanfaatkan dalam berbagai aktivitas individu, 

salah satu contoh yaitu mencari informasi dari webbrowser (google), pembuatan 

video dan pemutaran video melalui media sosial, email, games, dan melakukan 

pembelian dan pembayaran pada market place smartphone Smartphone juga dapat 

digunakan untuk mencatat keuangan dengan menggunakan aplikasi yang telah 

diunduh dari playstore yaitu Google spreadsheet (Erstiawan and Alifianto 2021). 
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Google Spreadsheet termuat dalam smartphone dan dapat digunakan 

dimanapun lokasi pelaku usaha. Dengan adanya google spreadsheet yang 

terkoneksi langsung dengan internet, maka transaksi yang terjadi dapat secara 

langsung dicatat kedalam aplikasi dan pada saat itu juga transaksi dapat tercatat 

dengan baik. Fitur yang terdapat pada google spreadsheet memiliki keunikan 

tersendiri untuk dapat dikelola dan digunakan menghasilkan laporan penjualan dan 

pembelian, laporan keuangan perperiode, buku bantu termasuk piutang dan lain 

sebagainya (Erstiawan and Alifianto 2021). 
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BAB 3 

METODE PENELITIAN 

 

3.1 Tempat dan waktu 

3.1.1 Tempat Penelitian  

Tempat dilaksanakanya perancangan dan pembuatan prototipe alat 

pemantaun kecepatan dan arah angin dilakukan di laboratorium Program Studi 

Teknik Mesin Fakultas Teknik Universitas Muhammadiyah Sumatera Utara. 

3.1.2 Waktu Penelitian 

Adapun waktu pelaksanaan pada penelitian ini dapat dilihat pada tabel 3.1. 

Tabel 3.1 Waktu kegiatan penelitian  

No Kegiatan 
Waktu (Bulan) 

1   2 3   4 5 6 

1 Pengajuan judul    

2 Studi literatur    

3 Seminar proposal    

4 Pembuatan alat    

5 Pengujian alat      

6 Analisa hasil pengujian      

7 Seminar hasil       

8 Penyelesaian skripsi       

 

3.2 Bahan Dan Alat 

3.2.1 Bahan Penelitian  

Bahan yang digunakan dalam penelitian ini adalah : 

1. PLA (Polylactic Acid) 

Pada penelitian ini PLA (Polylactic Acid) digunakan sebagai tinta 3D printing, 

seperti pada gambar 3.1 
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Gambar 3.1 PLA (Polylactic Acid) 

2. Mikrokontroler ESP32 

Pada penelitian ini Mikrokontroler ESP32 berfungsi sebagai board, seperti 

pada gambar 3.2 

 

Gambar 3.2 Mikrokontroler ESP32 

 

 

3. Sensor infrared  

Pada penelitian ini sensor infrared berfungsi sebagai mengukur perubahan 

posisi atau sudut rotasi suatu objek dengan tingkat presisi tinggi, seperti pada 

gambar 3.3 

 

Gambar 3.3 Sensor infrared 

 

4. Sensor Kompas HMC5883l 

Pada penelitian ini sensor adalah alat yang berfungsi untuk mendeteksi gejala 

yang berasal dari perubahan energy membantu dalam meramalkan pola cuaca 

seperti pada gambar 3.4 
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Gambar 3.4 Sensor HMC5883l 

5. Kabel jumper  

Pada penelitian ini Kabel jumper digunakan untuk menghubungkan komponen 

pada rangkaian elektronik, seperti pada breadboard atau modul sensor seperti 

pada gambar 3.5 

 

Gambar 3.5 kabel Jumper 

6. Bearing  

Pada penelitian ini bearing berfungsi untuk mengurangi gesekan antara dua 

bagian yang bergerak, seperti poros dan dudukan seperti pada gambar 3.6 

 

Gambar 3.6 Bearing 

7. Stainless steel  

Pada penelitian ini Stainless steel berfungsi sebagai poros karena memiliki 

ketahanan tinggi terhadap korosi, daya tahan mekanis yang baik, dan 

kemampuan menahan beban berat seperti pada gambar 3.7 
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Gambar 3.7 Stainless steel 

8. Box board  

Pada penelitian ini arduino box digunakan untuk menyimpan dan melindungi 

arduino dan komponen lainnya, seperti pada gambar 3.8 

 

 

Gambar 3.8 Box Board 

 

 

9. Progam Arduino IDE  

Pada penelitian ini program arduino IDE digunakan untuk memprogram sistem 

kontrol laju aliran liquid, seperti pada gambar 3.9 

 

 

Gambar 3.9 program Arduino uno 
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10. . Solidworks 2020 

Pada penelitian ini solidworks 2020 digunakan untuk merancang desain alat 

pengontrol laju aliran liquid, seperti pada gambar 3.10 

 

 

Gambar 3.10 Solidworks 2020 

11. Shield ESP32  

Pada penelitian ini Shield ESP32 selain untuk melindungin esp32nya juga 

berfungsi untuk menghubungkan komponen elektronik ke board, terlihat 

seperti gambar 3.11 

 

Gambar 3.11 Shield ESP32 

12. Wifi Modem 

Pada penelitian ini wifi modem berfungsi untuk memberi jaringan pada alat 

pengujian, terlihat seperti pada gambar 3.12 

 

Gambar 3.12 Wifi modem 
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3.2.2. Alat Penelitian  

Alat yang digunakan dalam penelitian adalah : 

1. Mesin 3D Printing 

Pada penelitian ini mesin 3D printing berfungsi untuk mencetak bentuk bentuk 

alat yang diperlukan, seperti pada gambar 3.13 

   Gambar 3.13 Mesin 3D Printing 

 

 

2. Win Tunnel 

Wind tunnel" (tunel angin) adalah fasilitas uji yang dirancang khusus untuk 

melakukan pengujian aerodinamika pada model atau prototipe objek dengan 

mengeksposnya pada aliran udara,seperti pada gambar 3.14  

 

Gambar 3.14 Win Tunnel 
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3.3 Bagan Alir Penelitian 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 3.15 Bagan alir penelitian 

 

Mulai 
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3.4 Rancangan Alat Penelitian 

 

Gambar 3.16 Desain Rancangan Alat  

Keterangan : 

1. Cup kecepatan angin 

Fungsi utama cup kecepatan angin adalah mengukur kecepatan angin. 

Semakin cepat rotor berputar, semakin tinggi kecepatan angin yang diukur 

2. Poros lengan cup kecepatan angin 

Poros lengan bertindak sebagai penghubung antara lengan yang memegang 

cup dengan sumbu utama alat 

3. As poros 

As poros berfungsi sebagai sumbu tempat lengan yang memegang cup 

(mangkuk) berputar saat terkena angin 

4. Tutup rumah sensor 
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utup rumah sensor melindungi komponen elektronik sensitif dari air hujan, 

embun, dan kelembapan tinggi yang dapat menyebabkan kerusakan, korosi, 

atau malfungsi pada sensor  

5. Housing/rumah sensor  

Rumah sensor berfungsi sebagai tempat sensor dan menjaga sensor dari 

berbagai kondisi cuaca 

6. Breket housing/breket rumah sensor 

Fungsi utama bracket adalah memberikan penopang yang kuat dan stabil 

bagi rumah sensor 

7. Sirip arah angin 

Sirip pada pengukur arah angin, atau wind vane, memiliki peran utama 

dalam menentukan dan menunjukkan arah datangnya angin 
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3.5. Prosedur penelitian  

3.5.1. Langkah-langkah yang dilakukan dalam melakukan prosedur penelitian 

pemantaunan kecepatan dan arah angin sebagai berikut : 

1. Desain  

Pada desain ini, pelaksanaan nya dilakukan di laboratorium komputer 

Fakultas Teknik Universitas Muhammadiyah Sumatera Utara. Desain ini 

dibuat menggunakan software Solidworks 2020. 

2. Creality  

Mengubah file solidworks menjadi file stl pada Creality memungkinkan 

pencetakan yang detail dari file desain 3D, menghasilkan prototipe atau 

produk akhir yang akurat 

3. 3D Printing 

Part/ model yang dibutuhkan dan sudah dibuat menjadi file di creality 

lalu mencetak/membuat part by part menggunakan 3D printing 

4. Assembly 

Setelah membuat dan mengumpulkan part/ model 3D printing 

selanjutnya adalah assembly atau merakit part/ model tersebut. 

3.5.2. Dalam perancangan sistem ini ada beberapa tahap  perancangan dalam 

pembuatan alat antara lain: 

1. Perancangan Program sensor infrared dan sensor Kompas HMC5883l 

pada aurduino ide digunakan untuk mengontrol sistem kerja 

Mikrokontroler ESP32  agar sesuai dengan konsep dan prinsip kerja alat 

yang dibuat. 

2. Perancangan Elektronik Menghubungkan board esp32 pada sensor 

infrared dan sensor HMC5883l 

3. Membuat struktur data base pada google sheet 

4. Perancangan program google sheet  pada aurduino ide yang nanti 

digunakan untuk menampilkan data dan hasil dari monitoring kecepatan 

dan arah angin dengan koneksi wifi 

3.5.3. Setelah membuat part part komponen  dan memprogram mikrokontroler 

semua dirakit menjadi satu 

3.5.4 Pengujian Alat 
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BAB 4 

HASIL DAN PEMBAHASAN 

4.1 Perancangan  

Tahapan Desain alat pemantauan kecepatan dan arah angin 

 

 

 

 

 

 

 

 

 

 

Gambar 4.1 Desain perancangan 

Dalam proses desain perancangan ini saya membuat dengan menggunakan 

software solidworks 2020. 

4.2 Tahapan pembuatan komponen  part by part dengan 3D printing 

4.2.1. Pembuatan Cup kecepatan angin 

 

 

 

 

 

 

 

Gambar 4.2 Desain cup dan hasil pencetakan  

Dalam proses pembuatan cup kecepatan angin seperti pada gambar 4.2 

menggunakan mesin 3D printing sebagai media percetakan yang dibagi 

dalam beberapa tahap yaitu : 

o Desain  
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Dalam proses desain perancangan cup kecepatan angin ini  membuat 

dengan menggunakan software solidworks 2020,dengan penentuan 

model dan sketsa awal,pemilihan bahan dan material,proses 2 

dimensi,proses 3 dimensi,proses assembly,proses trial and eror,proses 

cetak. 

o Stereolihography (STL) 

Setelah proses desain katup selesai, desain disimpan menggunakan 

file STL atau Stereolithography 

o Creality 

Setelah desain di simpan menggunakan file STL, lalu file di upload 

menggunakan software creality 

o G-Code 

G-Code adalah kode gerakan yang digunakan untuk mengontrol 

sebuah mesin 3D printing, yang dimana G-Code didapat setelah 

desain telah diupload kedalam software creality 

o 3D Printing 

Tahapan terakhir dalam proses pembuatan cup kecepatan angin 

adalah 3D Printing, yang dimana desain yang telah di buat dicetak 

dalam bentuk 3 dimensi menggunakan mesin 3D Printing seperti 

Gambar 4.2. 

4.2.2. Poros lengan cup kecepatan angin 

Gambar 4.3 Desain Poros lengan cup kecepatan angin dan hasil 

pencetakan  

Dalam proses pembuatan Poros lengan cup kecepatan angin seperti pada 

gambar 4.3 menggunakan mesin 3D printing sebagai media percetakan yang 

dibagi dalam beberapa tahap yaitu : 

o Desain  
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Dalam proses desain perancangan katup ini saya membuat dengan 

menggunakan software solidworks 2020 dengan penentuan model 

dan sketsa awal,pemilihan bahan dan material,proses 2 

dimensi,proses 3 dimensi,proses assembly,proses trial and eror,proses 

cetak. 

o Stereolihography (STL) 

Setelah proses desain katup selesai, desain disimpan menggunakan 

file STL atau Stereolithography 

o Creality 

Setelah desain di simpan menggunakan file STL, lalu file di upload 

menggunakan software creality 

o G-Code 

G-Code adalah kode gerakan yang digunakan untuk mengontrol 

sebuah mesin 3D printing, yang dimana G-Code didapat setelah 

desain telah diupload kedalam software creality 

o 3D Printing 

Tahapan terakhir dalam proses pembuatan Poros lengan cup 

kecepatan angin adalah 3D Printing, yang dimana desain yang telah 

di buat dicetak dalam bentuk 3 dimensi menggunakan mesin 3D 

Printing seperti gambar 4.3. 

4.2.3. As poros  

Dalam proses pembuatan as poros ini saya menggunakan Stainless steel 

sebagai as poros dengan ukuran 6mm seperti pada gambar 4.4. 

Gambar 4.4 As poros 
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4.2.4. Tutup rumah sensor  

 

 

 

 

 

 

     Gambar 4.5 Desain Tutup rumah sensor dan hasil pencetakan 

Dalam proses pembuatan Tutup rumah sensor  seperti pada gambar 4.5 

menggunakan mesin 3D printing sebagai media percetakan yang dibagi 

dalam beberapa tahap yaitu : 

o Desain  

Dalam proses desain perancangan katup ini saya menggunakan software 

solidworks 2020, dengan penentuan model dan sketsa awal,pemilihan 

bahan dan material,proses 2 dimensi,proses 3 dimensi,proses 

assembly,proses trial and eror,proses cetak. dengan diameter 6,5 cm dan 

terdapat tempat bearing/lahar yang berukuran 6mm dan 2  buah lubang 

baut pengunci. 

o Stereolihography (STL) 

Setelah proses desain katup selesai, desain disimpan menggunakan file 

STL atau Stereolithography 

o Creality 

Setelah desain di simpan menggunakan file STL, lalu file di upload 

menggunakan software creality 

o G-Code 

G-Code adalah kode gerakan yang digunakan untuk mengontrol sebuah 

mesin 3D printing, yang dimana G-Code didapat setelah desain telah 

diupload kedalam software creality 

o 3D Printing 

Tahapan terakhir dalam proses pembuatan Tutup rumah sensor adalah 

3D Printing, yang dimana desain yang telah di buat dicetak dalam bentuk 

3 dimensi menggunakan mesin 3D Printing seperti gambar 4.5. 



27 

 

 

4.2.5. Rumah sensor  

 

 

Gambar 4.6 Desain Rumah sensor dan hasil pencetakan 

Dalam proses pembuatan rumah sensor seperti pada gambar 4.6 

menggunakan mesin 3D printing sebagai media percetakan yang dibagi 

dalam beberapa tahap yaitu : 

o Desain  

Dalam proses desain perancangan katup ini saya menggunakan software 

solidworks 2020, dengan penentuan model dan sketsa awal,pemilihan 

bahan dan material,proses 2 dimensi,proses 3 dimensi,proses 

assembly,proses trial and eror,proses cetak, dengan diameter 6,5 cm dan 

tinggi 6cm,terdapat tempat bearing/lahar sebagai penunjang pergerakan 

poros yang berputar agar tetap stabil dan presisi dengan ukuran bearing 

6mm. 

o Stereolihography (STL) 

Setelah proses desain katup selesai, desain disimpan menggunakan file 

STL atau Stereolithography 

o Creality 

Setelah desain di simpan menggunakan file STL, lalu file di upload 

menggunakan software creality 

o G-Code 
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G-Code adalah kode gerakan yang digunakan untuk mengontrol sebuah 

mesin 3D printing, yang dimana G-Code didapat setelah desain telah 

diupload kedalam software creality 

o 3D Printing 

Tahapan terakhir dalam proses pembuatan Rumah sensor adalah 3D 

Printing, yang dimana desain yang telah di buat dicetak dalam bentuk 3 

dimensi menggunakan mesin 3D Printing seperti gambar 4.6.  

4.2.6. Breket housing/breket rumah sensor 

 

Gambar 4.7 Desain Breket housing/breket rumah sensor dan hasil 

pencetakan 

Dalam proses pembuatan Breket housing/breket rumah sensor seperti pada 

gambar 4.7,menggunakan mesin 3D printing sebagai media percetakan yang 

dibagi dalam beberapa tahap yaitu : 

o Desain  

Dalam proses desain perancangan katup ini saya membuat dengan 

menggunakan software solidworks 2020, dengan penentuan model dan 

sketsa awal,pemilihan bahan dan material,proses 2 dimensi,proses 3 

dimensi,proses assembly,proses trial and eror,proses cetak 

o Stereolihography (STL) 

Setelah proses desain katup selesai, desain disimpan menggunakan file 

STL atau Stereolithography 

o Creality 
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Setelah desain di simpan menggunakan file STL, lalu file di upload 

menggunakan software creality 

o G-Code 

G-Code adalah kode gerakan yang digunakan untuk mengontrol sebuah 

mesin 3D printing, yang dimana G-Code didapat setelah desain telah 

diupload kedalam software creality 

o 3D Printing 

Tahapan terakhir dalam proses pembuatan Breket housing/breket rumah 

sensor adalah 3D Printing, yang dimana desain yang telah di buat dicetak 

dalam bentuk 3 dimensi menggunakan mesin 3D Printing seperti gambar 

4.7. 

 

4.2.7. Sirip arah angin 

 

Gambar 4.8 Desain Sirip arah angin dan hasil pencetakan 

 

Dalam proses pembuatan Sirip arah angin seperti pada gambar 4.8 

menggunakan mesin 3D printing sebagai media percetakan yang dibagi 

dalam beberapa tahap yaitu : 

o Desain  

Dalam proses desain perancangan katup ini saya membuat dengan 

menggunakan software solidworks 2020, dengan penentuan model dan 

sketsa awal,pemilihan bahan dan material,proses 2 dimensi,proses 3 

dimensi,proses assembly,proses trial and eror,proses cetak, Panjang sirip 

15cm Dan lebar sirip 5cm. 

o Stereolihography (STL) 
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Setelah proses desain katup selesai, desain disimpan menggunakan file 

STL atau Stereolithography 

o Creality 

Setelah desain di simpan menggunakan file STL, lalu file di upload 

menggunakan software creality 

o G-Code 

G-Code adalah kode gerakan yang digunakan untuk mengontrol sebuah 

mesin 3D printing, yang dimana G-Code didapat setelah desain telah 

diupload kedalam software creality 

o 3D Printing 

Tahapan terakhir dalam proses pembuatan Sirip arah angin adalah 3D 

Printing, yang dimana desain yang telah di buat dicetak dalam bentuk 3 

dimensi menggunakan mesin 3D Printing seperti gambar 4.8 

4.2.8. Bandul sensor kecepatan angin 

 

Gambar 4.9 bandul sensor kecepatan angin 

Pada penelitian ini prinsip kerja sistem ini didasarkan pada pendeteksian 

setiap kali bandul melewati sensor infrared. 
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4.2.9. Assembly  semua part dan rangkaian komponen  

 

       Gambar 4.10 Proses merakit alat 

Proses merakit alat pengukur kecepatan dan arah angin dimulai dengan 

memasang komponen part by part yang sudah dicetak secara berurutan. 

Pertama, cup anemometer dipasang pada poros untuk mengukur kecepatan 

angin, diikuti dengan pemasangan sirip wind vane pada poros pengukur arah 

angin seperti pada gambar 4.10. 

Gambar 4.11 Proses perangkaian mikrokontroler dengan sensor 

sensor 

Proses perangkaian mikrokontroler dengan sensor dimulai dengan 

menghubungkan sensor-sensor, seperti sensor kecepatan angin dan sensor 

arah angin, ke pin input mikrokontroler. Kabel data dari setiap sensor 

dihubungkan ke pin yang sesuai pada mikrokontroler, biasanya pada port 

digital atau analog, tergantung jenis sensor seperti pada gambar 4.11. 
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Gambar 4.12 Rangkaian serial sensor  

4.3. Perancangan system 

4.3.1. Menseting alat dan sensor infrared pada Arduino ide 

Pada penelitian ini, sensor infrared digunakan untuk mendeteksi 

keberadaan objek sensor infrared digunakan untuk mengukur kecepatan 

rotasi (RPM - Revolutions Per Minute) sebuah objek, dalam hal ini bandul, 

yang berputar. Prinsip kerja sistem ini didasarkan pada pendeteksian setiap 

kali bandul melewati sensor infrared. Setiap kali sensor infrared mendeteksi 

pergerakan bandul (seperti melewati sebuah titik), sistem akan menghitung 

satu putaran penuh. Dengan menghitung waktu yang dibutuhkan untuk 

sejumlah putaran, nilai RPM dapat dihitung,  

Untuk menghitung RPM, diperlukan dua informasi: 

1. Waktu yang dibutuhkan untuk satu putaran (periode waktu). 

2. Jumlah putaran per menit. 

Rumus dasar untuk menghitung RPM adalah sebagai berikut: 

RPM =    60  

  Waktu Per Putaran ( Dalam Detik) 
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Di sini,menghitung waktu yang dibutuhkan untuk satu putaran penuh 

menggunakan sensor infrared, kemudian mengalikan hasilnya dengan 60 

untuk mendapatkan RPM. 

Adapun Langkah Langkah dalam memprogram sensor ini adalah sebagai 

berikut : 

• Hubungkan sensor ke Board esp32 : 

• VCC > Pin 3,3V 

• GND > Pin GND 

• OUT > 23 

Setelah terhubung antara Pin sensor ke ESP32, kemudian hubungkan 

kawat/kabel jumper pada ujung setiap pin seperti gambar 4.13. 

 

 

 

Gambar 4.13 Menghubungkan pin sensor ke board esp32 

• Selanjutnya, buka Arduino IDE kemudian Instalasi Library dan Driver 

ESP32 pada Arduino IDE. 

• Buka Arduino uno 

• Pergi ke file > Preferences 

• Tambahkan URL berikut pada kolom "Additional Board Manager 

URLs seperti pada gambar 4.14. 

 

Gambar 4.14 URL board manager 



34 

 

• Setelah itu, buka Tools > Board > Board Manager, cari "ESP32" dan 

instal. 

•   Setelah library diinstal, pilih board ESP32 dari menu Tools > Board 

> DOIT ESP32 DEVKITV1. 

• Pemrograman Sensor Infrared di Arduino IDE 

• Setelah perangkat keras terhubung, langkah selanjutnya adalah 

menulis program untuk memproses sinyal dari sensor infrared seperti 

pada gambar 4.15 

 

Gambar 4.15 Program sensor infrared (RPM) 

• setelah program diupload, buka serial monitor hasil pembacaan RPM 

dan atur baut potensial sampai tepat pada titik sensitifitas 

• selesai  

4.3.2. Memprogram sensor HMC5883l 

pada penelitian ini Sensor HMC5883L digunakan untuk mendeteksi arah 

berdasarkan medan magnet bumi. Penggunaan ESP32 dan Arduino UNO 

memberikan fleksibilitas dalam komunikasi dan pengolahan data dari sensor 

Sensor HMC5883L bekerja dengan mendeteksi perubahan medan magnet di 

sekitarnya dan menghasilkan nilai dalam tiga sumbu (X, Y, dan Z) yang bisa 

digunakan untuk menentukan arah orientasi. 

Adapun Langkah Langkah dalam memprogram sensor ini adalah sebagai 

berikut : 

• Hubungkan sensor ke Board esp32 : 

• Pin VCC > Pin 3.3V ESP 32 

• Pin GND > Pin GND ESP 32 
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• Pin SDA > Pin 21 ESP32 (SDA) 

• Pin SCL > Pin 22 ESP 32 (SCL) 

• Pin DRDY (Optional) 

Setelah terhubung antara Pin sensor ke ESP32, kemudian hubungkan 

kawat/kabel jumper pada ujung setiap pin seperti gambar 4.16 

 

 

Gambar 4.16 Menghubungkan pin sensor ke board esp32 

• Pemrograman Sensor HMC5883L di Arduino IDE 

Setelah koneksi sensor terpasang, langkah selanjutnya adalah menulis 

program untuk membaca data medan magnet dari sensor HMC5883L. 

Berikut adalah kode untuk membaca data dari sensor HMC5883L 

menggunakan ESP32 seperti pada gambar 4.17 

 

Gambar 4.17 Program sensor HMC5883l 

• Mengunggah Kode ke Board ESP32 

• Sambungkan board esp32 ke laptop/computer menggunakan kabel USB 
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• Pada Arduino IDE,pilih Tools > Board > ESP32 Dev Module 

• Pilih port yang sesuai  dengan ESP32 di Tools > Port 

• Klik tombol Upload untuk mengunggah program ke ESP32 

• Setelah unggah selesai, buka serial monitor untuk melihat hasil data dari 

sensor HMC5883l. 

• Selesai  

4.3.3. Penggabungan program sensor infrared dengan program sensor 

HMC5883l 

Setelah kedua sensor sudah diprogram maka program kedua sensor 

digabungkan menjadi satu, Pada penggabungan ini, sensor infrared akan 

bertindak sebagai sistem deteksi awal, sedangkan sensor HMC5883L akan 

bertugas memberikan data orientasi. Penggabungan program memungkinkan 

kedua sensor beroperasi secara bersamaan, dan informasi dari keduanya bisa 

digunakan untuk aplikasi yang lebih kompleks, seperti sistem pelacakan 

objek dengan arah orientasi. 

Berikut adalah program gabungan sensor infrared dengan sensor 

HMC5883l. 

 

Gambar 4.18 Program gabungan  
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Gambar 4.19 Program gabugan  

 

Gambar 4.20 Program gabungan  

4.3.4. Kalibrasi sensor  

Kalibrasi sensor langkah penting untuk memastikan bahwa kedua sensor, 

yaitu sensor infrared dan sensor HMC5883L, bekerja dengan akurasi yang 

tepat dalam program gabungan. Dalam proses kalibrasi, sensor infrared harus 

mampu mendeteksi objek dengan sensitivitas yang sesuai, sementara sensor 

HMC5883L harus menghasilkan data orientasi yang akurat berdasarkan 

medan magnet bumi. Kalibrasi yang tepat akan meminimalkan kesalahan 

dalam pembacaan sensor dan meningkatkan performa keseluruhan system. 

• Kalibrasi Sensor Infrared 

• Penyesuaian Jarak Deteksi 

• Pengujian dengan Berbagai Objek 

• Pengujian Respons Cepat 

• Kalibrasi Sensor HMC5883L 
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• Rotasi Sensor pada Semua Sumbu, Untuk mengkalibrasi 

sensor HMC5883L, putar sensor secara perlahan pada ketiga 

sumbu (X, Y, dan Z) dalam lingkaran penuh. Langkah ini 

membantu sensor untuk mendapatkan pembacaan medan 

magnet bumi yang lebih akurat dan menstabilkan data 

• Penyesuaian Offset 

 

Gambar 4.21 Program kalibrasi 

• Selesai  

4.3.5. Perancangan Perangkat Lunak (Software) 

Pada perancangan alat ini menjelaskan pembuatan Google Sheet untuk 

mengirim data hasil percobaan, adapun Langkah-langkah membuat Google 

Sheet sebagai berikut : 

• Buka Google Sheet 

• Membuat spreadsheet baru dan beri nama spreadsheed dan 

juga lembar sheet sesuai keperluan (misalnya: "Data IOT 

Kecepatan dan Arah angin") dan lembar sheet (misalnya : 

"Data Kecepatan dan Arah Angin_Sheet") 

• Mengisi kolom,baris untuk membaca nilai yang didapat dalam 

pengujian seperti pada gambar 4.22 

 

Gambar 4.22 Membuat Spreadsheet Baru 
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• Mencatat dan Menyimpan Google Sheets Project Name, 

Google Sheets ID, Sheet Name pada NotePad atau 

sejenisnya,seperti gambar 4.23 

 

            Gambar 4.23 Menyimpan Data Pada NotePad 

• Setelah itu mengAktifkan Google Apps Script dengan klik 

Extensions > Apps Script 

• Kemudian membuat kode Google Apps Script untuk 

membaca data,seperti pada gambar 4.24 

 

Gambar 4.24 Membuat Kode Google Apps Script 

• Setelah itu menyimpan kode dengan klik > Terapkan > Deployment baru > 

Pilih jenis kemudian klik Aplikasi web > Memilih akses siapa aja > klik 

terapkan. 

• Kemudian salin URL web > klik selesai,seperti gambar 4.25 
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Gambar 4.25 URL Web 

 

 

 

• Setelah URL Web tersebut dicopy lalu tambahkan URL seperti pada 

gambar 4.26 

Gambar 4.26 URL Pembaca Data 

• Setelah itu mencoba URL yang telah di salin tadi,jika tidak ada masalah 

dalam kode App Script nya maka hasilnya akan seperti gambar 4.27 

 

 
Gambar 4.27 Kode Apps Script terbaca 

• Selesai  

 

 

4.3.6. Penggabungan program sensor dan program google sheet 

• Langkah-Langkah Penggabungan Program 

• Sensor HMC5883L (Arah): 

• VCC > 3.3V ESP32 

• GND > GND ESP32 

• SDA > PIIN 21 ESP32 

• SCL > PIN 22 ESP32 
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• Sensor infrared  

• VCC > 3.3V ESP32 

• GND > GND ESP32 

• OUT > PIN 23 ESP32 

• Instalasi Library yang Diperlukan 

• Library HMC5883L: Instal melalui Library Manager di Arduino IDE. 

• Library ESP32 Board: Jika belum terinstal, pastikan Anda sudah 

menambahkannya di Boards Manager. 

• Penggabungan Kode Program yang sudah dibuat sebelumnya,gabungkan 

kode untuk membaca data dari sensor HMC5883l dan Sensor Infrared 

serta program google sheets,seperti gambar 4.28. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Gambar 4.28 Program gabungan google sheet dan program sensor 

 

• Masukan SSID dan password koneksi Wifi yang akan menghubungkan 

board dengan google sheets 

• Tambahkan link google sheets pada program di kolom yang tersedia 

• Mengunggah Program ke ESP32 

• Sambungkan board ESP32 ke komputer menggunakan kabel USB 

• Di Arduino IDE, pilih board DOIT ESP32 DEVKIT V1 dari Tools > 

Board. 
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• Pilih port yang sesuai dengan ESP32 di Tools > Port. 

• Klik Upload untuk mengunggah program ke ESP32. 

• Setelah unggah selesai, buka Serial Monitor untuk memantau koneksi dan 

pengiriman data ke Google Sheets. 

• Selesai. 

4.4. Pengujian Alat dan Sistem Monitoring pada win tunnel 

 

Pengujian alat dan sistem yang dilakukan di laboratorium fakultas Teknik 

mesin universitas Muhammadiyah sumatera utara dengan menggunakan win 

tunnel dengan frekuensi inverter seperti pada gambar 4.29, untuk mengetahui 

dan menguji apakah sensor-sensor bekerja dengan baik dan sistem monitoring 

berhasil mengirim data atau tidak. Pengujian dilakukan untuk membaca hasil 

pengukuran yang dilakukan dan di tampilkan pada Google Sheet yang telah 

dibuat. 

 

 
Gambar 4.29 win tunnel 

Proses pengujian dilakukan dengan memasang alat dan modem wifi pada win 

tunnel seperti pada gambar 4.30 Setelah semua komponen selesai dan terhubung 

dengan sumber daya, pemantauan dilakukan dengan mebuka google sheet dan 

melihat Data_Esp32_IOT yang dikirim. 
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Gambar 4.30 pemasangan alat pada wintunnel 

 

Hasil monitoring ditampilkan pada tabel google sheet yang telah terhubung 

dengan alat menggunakan program IoT (internet of things). Google sheet 

merupakan server yang menampung data dari hasil pembacaan alat. 

 

 

Gambar 4.31 Hasil pemabacaan google sheets 

Dari hasil pengujian, diperoleh rata-rata kecepatan angin berdasarkan variasi 

frekuensi inverter setiap 10 Hertz, dengan 100 data pengukuran pada setiap 

frekuensi. Tabel di bawah ini menyajikan data hasil pengukuran tersebut. 

Tabel 4.1 Hasil nilai RPM masing masing frekuensi 
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No 

 

Frekuensi inverter 

(10) Hertz 

Frekuensi inverter 

(20) Hertz 

Frekuensi inverter 

(30) Hertz 

Frekuensi inverter 

(40) Hertz 

1 142 RPM 386 RPM 409 RPM 534 RPM 

 

 

 

Gambar 4.32 Grafik kecepatan angin 

Grafik di atas menunjukkan hubungan antara frekuensi inverter (Hz) dengan 

kecepatan putaran kipas dalam wind tunnel, yang dinyatakan dalam RPM 

(Revolutions Per Minute). Data frekuensi inverter diukur pada empat titik utama: 

10 Hz, 20 Hz, 30 Hz, dan 40 Hz. Hasil pengujian menunjukkan bahwa seiring 

dengan peningkatan frekuensi, kecepatan putaran kipas juga meningkat secara 

linear. Pada frekuensi 10 Hz, kecepatan putaran kipas sekitar 1000 RPM, sementara 

pada frekuensi 40 Hz, kecepatan putaran kipas mendekati 5000 RPM. Hal ini 

menunjukkan bahwa frekuensi inverter berpengaruh langsung terhadap kecepatan 

rotasi kipas, yang pada gilirannya memengaruhi kecepatan aliran udara di dalam 

wind tunnel 

Dari tabel 4.2 diabwah ini, pengujian pembacaan arah angin yang dibaca dari 

sensor arah angin menunjukkan hasil yang indentik antara pengujian ke-1 sampai 

ke-5. 
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Tabel 4.2 hasil pengujian sensor arah angin  

No 

 

Sudut Arah mata angin 

1 0° Utara 

2 60° Timur laut 

3 90° Timur 

4 160° Barat laut 

5 180° Selatan 

Hasil pengujian sensor arah angin pada berbagai frekuensi inverter (10, 20, 30, 

dan 40 Hertz) menunjukkan konsistensi arah angin di beberapa sudut, sementara 

terdapat perubahan arah pada sudut tertentu seiring dengan peningkatan frekuensi. 

Pada sudut 20°, 40°, 100°, dan 180°, arah angin tetap konstan, yaitu berturut-turut 

menunjukkan arah Utara, Timur Laut, Timur, dan Selatan, meskipun frekuensi 

inverter meningkat dari 10 hingga 40 Hertz. 

Hal ini menunjukkan bahwa meskipun kecepatan aliran udara dipengaruhi oleh 

perubahan frekuensi inverter, arah angin pada sebagian besar sudut tetap stabil. 

Hanya pada sudut 160° yang menunjukkan adanya perubahan arah angin ketika 

frekuensi inverter dinaikkan. 

4.5. Percobaan pengambilan data pada Tambak Udang 

Percobaan langsung alat dan sistem monitoring dilakukan pada tambak 

udang pada siang hari, seperti yang ditunjukkan pada Gambar 4.33. Lokasi 

percobaan berada di Jalan Besar Pantai Kelang, Desa Lubuk Bayas, Kecamatan 

Perbaungan, Kabupaten Serdang Bedagai, Sumatera Utara, Indonesia. 
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Gambar 4.33 Lokasi Tambak Udang 

 

Proses pengambilan data dilakukan dengan memasang alat dan modem wifi 

pada tambak udang tersebut seperti pada Gambar 4.34. Setelah semua komponen 

selesai dan terhubung dengan sumber daya, pemantauan dilakukan dengan mebuka 

google sheet dan melihat data Kecepatan dan arah angin yang dikirim. Proses 

pemantauan dilakukan dirumah pemilik dengan jarak +  2 KM dari lokasi tambak. 

 

 
Gambar 4.34 Pemasangan alat pengujian 

 

Hasil monitoring kecepatan dan arah angin pada tambak ditampilkan dalam 

tabel Google Sheet yang terhubung dengan alat menggunakan program IoT 

(Internet of Things). Data tersebut akan dikirim secara otomatis ke Google Sheet, 

mirip dengan percobaan yang dilakukan pada wind tunnel. 
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Gambar 4.35 Hasil pengujian 

 

Pengujian dilakukan pada pukul 11.00 pm hingga pukul 11.40 pm dengan real 

time pembacaan selama 10 detik secara berkala. Dari hasil pengujian kecepatan dan 

arah angin pada tambak didapatkan hasil rata-rata kecepatan dan arah angin pada 

tambak di setiap 10 menit  dapat dilihat dalam tabel dibawah ini. 

Tabel 4.3 Hasil Pengujian pada tambak udang 

Kecepatan angin  Sudut Arah mata angin 

380 RPM 40° Timur laut  

450 RPM 33° Timur laut 

540 RPM 87° Timur  

480 RPM 70° Timur  

 

Dari hasil pengujian yang dilakukan terlihat pada tabel 4.3 rata-rata nilai 

kecepatan angin dalam pengujian di setiap 10 menit adalah 462,5 RPM setara 

dengan 8.69 km/jam..  

Dari pengukuran yang dilakukan selama 40 menit, kecepatan angin di tambak 

udang terlihat jauh di bawah ambang batas yang berpotensi berbahaya. Kecepatan 

angin tersebut tidak akan menimbulkan dampak signifikan terhadap lingkungan 

tambak atau kesehatan udang yang dibudidayakan. 

Ambang batas aman untuk kecepatan angin pada tambak udang dapat 

bervariasi tergantung pada berbagai faktor, termasuk jenis udang yang 

dibudidayakan, kondisi tambak, dan infrastruktur yang ada. Namun, secara umum, 

berikut adalah beberapa panduan mengenai kecepatan angin yang dianggap aman 

untuk tambak udang: 

 Kecepatan Angin Rendah (0-10 km/jam): 
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• Kecepatan angin dalam kisaran ini biasanya dianggap aman dan tidak 

memberikan dampak negatif pada tambak udang. Kondisi ini baik untuk 

pertumbuhan udang, karena sirkulasi udara yang baik dapat meningkatkan 

kadar oksigen di dalam air. 

Kecepatan Angin Sedang (10-20 km/jam): 

• Angin dalam rentang ini masih bisa dianggap aman untuk tambak udang, 

tetapi pemilik tambak perlu lebih waspada. Pemantauan lebih intensif 

terhadap kualitas air dan kondisi lingkungan mungkin diperlukan. 

Kecepatan Angin Tinggi (20-30 km/jam): 

• Pada kecepatan angin ini, risiko mulai meningkat. Gelombang dan arus 

yang lebih kuat dapat mempengaruhi stabilitas tambak dan menyebabkan 

kerusakan pada infrastruktur. Pemilik tambak disarankan untuk memeriksa 

kondisi udang dan memastikan bahwa sistem aerasi berfungsi dengan baik. 

Kecepatan Angin Sangat Tinggi (>30 km/jam): 

• Kecepatan angin di atas 30 km/jam dapat berbahaya bagi tambak udang. 

Gelombang besar dan arus yang kuat dapat merusak tambak, 

mengakibatkan pengendapan material, serta meningkatkan risiko stres dan 

kematian pada udang. Pada kondisi ini, pemilik tambak disarankan untuk 

melakukan langkah-langkah mitigasi, seperti menyiapkan penahan angin 

atau bahkan menghentikan kegiatan tambak jika diperlukan. 
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BAB V 

KESIMPULAN DAN SARAN 

5.1. KESIMPULAN 

Berdasarkan hasil perancangan, pengujian, serta pengambilan data dari hasil 

penelitian yang dilakukan dapat diambil kesimpulan sebagai berikut :/ 

1. Melalui serangkaian pembuatan dan pengujian yang telah 

dilaksanakan, alat pemantauan kecepatan dan arah angin ini 

menunjukkan kinerja yang baik dan mampu memberikan data. 

2. Dari pengujian yang dilakukan memungkinkan pemantauan jarak jauh 

yang efisien, lebih akurat dibandingkan metode manual, dan dapat 

diakses melalui perangkat seluler atau komputer. Hasil pengukuran 

ini bisa digunakan dalam berbagai aplikasi, seperti prakiraan cuaca, 

pertanian, dan manajemen sumber daya energi. 

5.2. SARAN 

Berdasarkan penelitian diatas terdapat beberapa saran antara lain : 

1. Perancangan menggunakan modul internet yang lebih canggih untuk 

menunjang kecepatan pengiriman data agar lebih cepat. 

2. Sistem pengolah data bisa diganti dengan modul yang lebih baik dari 

Spreadsheet untuk pemrosesan data yang lebih cepat dan baik. 

3. koneksi wifi yang menghubungkan ke mikrokontroler harus selalu 

stabil karena akan mempengaruhi pada saat pengamatan berlangsung 

dan alat masih secara prototype jadi ketika pemasangan berlangsung 

koneksi antara sensor terkadang putus karena koneksi yang kurang 

baik antara komponen sensor dengan komponen lainnya perlu solder 

jika dibuat secara permanen. 
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